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1 General 
1.1 Bartels AutoEngineer Product Line 
The following Bartels AutoEngineer software configurations are available: 

• Bartels AutoEngineer Schematics 

• Bartels AutoEngineer Light 

• Bartels AutoEngineer Economy 

• Bartels AutoEngineer Professional 

• Bartels AutoEngineer HighEnd 

• Bartels AutoEngineer IC Design 

• Bartels AutoEngineer FabView 

Bartels AutoEngineer Professional is the standard BAE software configuration. BAE Professional is available for PCs 
with Windows, Linux or DOS operating systems. BAE Schematics, the schematic editor of BAE Professional is freely 
available and can be operated in stand-alone mode. Demo software configurations of BAE Professional (fully-featured 
except for data output) are available free of charge for test and evaluation purposes. 

Bartels AutoEngineer Light is a shareware price-level BAE configuration for educational purposes and/or semi-
professional users, available for PCs with Windows, Linux or DOS operating systems. BAE Light has full BAE 
Professional functionality, however, limited to a maximum PCB layout size of 180mm * 120mm and a maximum of two 
signal layers for manual routing and Autorouter. 

BAE Economy is a low-price BAE configuration for educational purposes and/or small business users, available for PCs 
with Windows, Linux or DOS operating systems. BAE Economy has full BAE Professional functionality, however, 
limited to a maximum PCB layout size of 350mm * 200mm and a maximum of four signal layers to be simultaneously 
routed by the Autorouter. 

Bartels AutoEngineer HighEnd is available for workstations and for PC systems (Windows 95/98/ME/NT/2000/XP, 
Linux). BAE HighEnd utilizes special operating system characteristics (multi-tasking, multi-windowing, virtual memory 
management, etc.) to implement advanced features and functions such as HighSpeed kernel, in-built messaging system 
to support advanced communication between different BAE modules, in-built multi-tasking to support multiple project 
views, global net highlight, cross-probing, selective layout short-circuit display, extremely fast Mincon airline calculation, 
optimized data structures for high Autorouter performance, advanced Neural Rule System features, rule-driven Neural 
Autorouter, nettype-specific routing area definitions, net-specific maximum via count settings, net-specific maximum 
connection length settings, etc. 

BAE HighEnd is optionally available with Bartels AutoEngineer IC Design (BAEICD). BAE IC Design is a complete 
CAD/CAM system for the physical design of integrated circuits (gate arrays, standard cells, custom ICs and/or ASICs). 
BAEICD consists of a series of system components such as IC Mask Editor, IC Autoplacement, IC Autorouter, IC DRC 
(Design Rule Check) and GDS-II and CIF standard interfaces. 

Bartels AutoEngineer FabView is a low-cost PCB layout viewer with manufacturing data output functions. BAE 
FabView is intended for PCB manufacturing departments and service providers who only have to produce manufacturing 
data and print/plot outputs but don't have to edit layouts. BAE FabView can be used together with BAE Professional 
and/or BAE HighEnd. BAE FabView provides the same functionality, however, the functions for saving design changes 
to BAE project files are deactivated. 
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1.2 System Requirements 
General System Requirements 

A VGA or higher resolution monitor with a screen resolution of at least 800*600 pixels and a mouse or a corresponding 
pointing device are required on any BAE platform. 

Up to 40 Mbytes hard disk space are required for installing the BAE software. 

Operating System 

BAE Schematics, BAE Light, BAE Economy, BAE Professional and BAE FabView versions are available for Linux 
(Kernel 2.0.x and above), Windows XP, Windows 2000, Windows NT 4.0, Windows NT 3.51, Windows ME (Millenium 
Edition), Windows 98, Windows 95 and MS-DOS. 

BAE HighEnd systems are available for Hewlett-Packard 9000/7xx workstations with OSF/Motif and/or X11 and for PCs 
with Linux (Kernel 2.0.x and above), Windows XP, Windows 2000, Windows NT 4.0, Windows NT 3.51, Windows ME 
(Millenium Edition), Windows 98 and Windows 95 operating systems. 

PC System Requirements 

PC systems should be equipped with a Pentium (80586, 80686) or at least a 80486DX processor. Any compatible 
processor such as AMD-K6 or AMD-K7 (Athlon) will also do. 

A minimum of 8 Mbytes RAM is required for DOS systems (16 Mbytes RAM recommended). A minimum of 32 Mbytes 
RAM is required for Windows 95/98/ME/NT/2000/XP and Linux systems (64 Mbytes RAM or more recommended). 

The BAE software is usually provided on CD-ROM, i.e., a CD-ROM drive is required to install the software. 

A hardlock key is used to protect BAE Economy, BAE Professional and BAE Fabview Windows and DOS versions 
against software piracy. I.e., a printer port (LPT1, LPT2 or LPT3) is required to run these BAE versions under DOS and/or 
Windows. 

On Linux systems, either a printer port (for the hardlock key) or an Ethernet card is required for checking the software 
authorization of BAE Economy, BAE Professional, BAE HighEnd and BAE FabView. 

1.3 Documentation 
Both the Bartels AutoEngineer User Manual and the Bartels User Language Programmer's Guide have been completely 
revised and are provided in HTML and PDF format (in the baedoc directory of the BAE CD-ROM). 
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1.4 Installation Guide 
Preparing for Update Installations 

The BAE library and User Language directory contents are replaced when performing update installations. Thus it is 
strongly recommended to backup any user-specific data from these directories before installing the BAE update and to 
restore the required data afterwards. The same backup and restore process should be applied to BAE programs directory 
files with extensions .dat, .def, .fnt and .ini when just updating from earlier BAE versions since these files can 
contain user-defined color tables, layer definitions, Gerber aperture tables and character fonts which are overwritten 
during update installations. 

BAE updates can be installed to new directories. You should then copy the BAE system files with the .dat, .def, .fnt 
and .ini extensions from the old BAE programs directory to the BAE programs directory of the new installation to 
transfer all user-specific system definitions such as color tables and Gerber aperture tables to the new BAE installation. 

The BAE (update) installation procedures always (re-)install the BAE system files ending on .vdb to the BAE programs 
directory. These files contain version-dependent system data such as the compiled User Language programs of the BAE 
software (ulcprog.vdb) and the compiled rule definitions of the BAE software (brules.vdb). It is therefore not 
necessary to run the time-consuming batch for compiling the User Language sources provided with the BAE software or 
to compile the rule definition files deliverd with the BAE software. However, customer-specific User Language programs 
and rule definitions developed and compiled under the previously installed BAE version must be re-compiled after 
performing a BAE Update Installation. 

Software Security Module and License Files 

The BAE PC software for Windows and DOS (except for BAE Demo, BAE Light and BAE Schematics) is protected by a 
hardlock key (dangle) which must be plugged onto one of the parallel ports (LPT1, LPT2 or LPT3) of your PC. Switch off 
your computer before mounting the hardlock key shipped with the software; otherwise the dangle could be damaged by 
high voltage! If you have connected a peripheral device such as a laser printer to the hardlock key, then you must always 
switch on the peripheral device before switching on your computer to avoid hardlock key check problems. 

The BAE PC software provides the license files according to the available software configurations as shown in the table 
below. You will be asked to select the BAE software configuration (and thus the appropriate license file) when installing 
the BAE software. Make sure to select the BAE software configuration to be installed and/or authorized on your computer. 

Table 1: BAE Software License Files 

Software 
Configuration 

License File 
Name Note 

BAE Demo demo.cfg SCM and Layout; no Hardlock Key, no (CAM) output 

BAE Schematics schema.cfg SCM only; no HardlockKey 

BAE Light see note SCM and Layout; no Hardlock Key, customer-specific CFG file is provided 
on purchase 

BAE Economy economy.cfg SCM and Layout 

BAE Professional autoeng.cfg SCM and Layout 

BAE HighEnd highend.cfg SCM and Layout 

BAE Layout layout.cfg Layout only; required/provided only for updating from BAE Versions older 
than BAE Version 4.6 

BAE IC Design icdesign.cfg SCM, Layout and IC Design 

BAE FabView fabview.cfg CAM/manufacturing data output; save to DDB file deactivated 

The router.cfg license file matching the BAE software configuration authorized on your computer must be available in 
the BAE programs directory. I.e., to install the correct license file you can also copy the desired CFG file to router.cfg 
in the BAE programs directory instead of selecting the valid BAE configuration during BAE software installation 

BAE Demo software is intended for evaluation purposes only. BAE Demo cannot produce any CAM or User Language 
output. BAE Demo masks Layout board elements to prevent from processing with productive software configurations 
afterwards. I.e., the BAE user version are not able to read Demo jobs, however, we are able to convert these jobs. 
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Windows Installation 

Under Windows 95/98/ME/NT/2000/XP, the BAE setup program for installing BAE Demo, BAE Schematics BAE Light, 
BAE Economy, BAE Professional, BAE HighEnd, BAE IC Design and/or BAE FabView should start automatically 
after inserting the BAE CD-ROM to the CD-ROM drive. If this doesn't happen, simply start the setupen.exe program 
from the CD-ROM using the Run function from the Windows Start menu. Please follow the instructions of the setup 
program. 

The setup ends with the BAE software configuration. Please select the BAE configuration which is authorised for your 
machine (BAE Demo, BAE Schematics, BAE Light, BAE Economy, BAE Professional, BAE HighEnd, BAE IC 
Design oder BAE FabView; see also table 1). 

MS-DOS Installation 

For installing BAE Schematics, BAE Economy, BAE Professional, BAE HighEnd or BAE FabView under MS-DOS, 
the CD-ROM must be inserted to the CD-ROM drive, and the drive and directory must be set accordingly. E.g., to install 
the BAE software from CD-ROM drive D, insert the BAE CD-ROM to CD-ROM drive D, and enter the following commands 
to the DOS prompt: 

> D:  
> install  

The instructions issued on the screen should be followed carefully once the install program is started. First you are asked 
for the BAE user interface language (e.g., English, German, etc.) and for the operating system host platform (DOS, 
Windows NT, etc.). 

The install program provides different modes for performing either new Installation or Update installations. The Update 
install mode is strongly recommended when just updating from earlier BAE Versions; this prevents the install program 
from overwriting special BAE system and setup files ending on .dat, .def and .fnt (otherwise, user-defined color 
tables, aperture tables, fonts, layer definitions, library access path settings and menu setups stored with these files might 
get lost). 

After selecting the install mode, you will be prompted to specify the destination directories for installing the programs, the 
libraries, the User Language source files and the examples and test jobs. You can exclude certain destination directories 
by deleting the corresponding path names. Thus more experienced BAE users can e.g., suppress the installation of the 
BAE example jobs, or re-install certain parts of the BAE software later. For security reasons, the install parameter settings 
are verified with user query before starting the installation process. The destination directories are automatically created if 
necessary. The install program automatically copies the BAE software files to the selected destination directories on the 
hard disk. 

At the end of the install process, the install program asks for the licensed BAE software configuration and/or software 
authorization file (see table 1). 
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The DOS versions of the BAE software are shipped with a series of graphic device drivers. During the installation you are 
asked to select an appropriate BAE graphic device driver. Table 2 lists the DOS graphic device drivers supplied with the 
Bartels AutoEngineer software. Please select the graphic device driver matching the video adapter and/or graphic card 
installed with your computer. Or simply select standard VGA driver VGA480 if you are not sure about which driver to 
select. VGA480 is assumed to run on almost any PC system. The selected graphic driver file is copied to the bae.dev 
file in the BAE programs directory. You can manually copy a different driver (e.g., with higher resolution) even after 
running the BAE DOS installation. 

Table 2: BAE Graphic Device Drivers 

Graphic Driver Type Resolution Chip Set/Manufacturer 

CCD480.DEV  PGA 640x 480 IGC (Cad Card) 

EGA350.DEV  EGA 640x 350 Standard 

EGA480EW.DEV EEGA 640x 480 EGA Wonder 

EGA480GE.DEV EEGA 640x 480 Genoa, ATI 

EGA600EW.DEV EEGA 800x 600 EGA Wonder 

EGA600GE.DEV EEGA 800x 600 Genoa, ATI 

EGA600PA.DEV EEGA 800x 600 Paradise 

QPC1024.DEV  - 1280x1024 Datapath QPDM 

QPDM768.DEV  VGA 1024x 768 AMD QPDM 

QPDM1024.DEV VGA 1280x1024 AMD QPDM 

VGA480.DEV  VGA 640x 480 Tseng ET3000 / ET4000 

VGA600.DEV  VGA 800x 600 Tseng ET3000 / ET4000 

VGA768.DEV  VGA 1024x 768 Tseng ET3000 

TSENG768.DEV VGA 1024x 768 Tseng ET4000 

VESA600.DEV  VESA 800x 600 various 

VESA768.DEV  VESA 1024x 768 various 

MACH768.DEV  - 1024x 768 ATI Mach 64 

MACH1024.DEV - 1280x1024 ATI Mach 64 

MACH1200.DEV - 1600x1200 ATI Mach 64 

MGA600.DEV  - 800x 600 Matrox Millenium/Mystique 

MGA768.DEV  - 1024x 768 Matrox Millenium/Mystique 

MGA1024.DEV  - 1280x1024 Matrox Millenium/Mystique 

MGA1200.DEV  - 1600x1200 Matrox Millenium/Mystique 

TIGA.DEV  TI variable Texas TMS34010 / TMS34020 
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It is strongly recommended to add the BAE programs directory path to the PATH environment variable. Load the 
autoexec.bat file to your text editor and check whether autoexec.bat contains a PATH statement or not. If there is 
already a PATH statement defined in autoexec.bat, then just add the following program path link to the PATH statement 
(assume BAE programs directory c:\bae): 

;c:\bae 

If there is no PATH statement defined in autoexec.bat, then insert the following PATH statement (assume BAE 
programs directory c:\bae): 

PATH=c:\bae 

You can also insert the following command at the end of the autoexec.bat file to include the BAE programs directory 
path name with the PATH variable: 

PATH c:\bae;%path% 

With the PC versions of the BAE software an environment variable called BAETMP can be defined for optionally specifying 
a BAE temporary directory to avoid problems with temporary file generation on network-based PC/MS-DOS systems. To 
specify the BAE temporary directory the following command must be added to the autoexec.bat file: 

SET BAETMP=<dirpath>\ 

<dirpath> is the path name of the temporary directory (e.g., d:\baetmp; the backslash at the end of the path name is 
required). 

The config.sys file must contain the following statements: 

BUFFERS=<b> 
FILES=<f> 

The number <b> of buffers should be at least 30, and the number <f> of files should be at least 20. 

Note that you must reboot your computer if you made any changes to the config.sys or autoexec.bat. Otherwise 
you might not be able to start BAE. 

The BAE DOS software works in Protected Mode, i.e., there is no 640 Kbytes barrier. Bartels AutoEngineer uses the 
Phar Lap 386|DOS Extender, which supports DPMI, VCPI, EMM386, XMS/HIMEM, VDISK and INT 15h. However, in 
special cases (e.g., with certain third party software configurations) it might be necessary to remove conflicting memory 
managers. It is possible to reconfigure the BAE programs, if you wish to restrict the way in which BAE uses memory; 
please contact us for more detailed information in case. With EMM386 installed under MS-DOS 6.x it is strongly 
recommended to add the NOVCPI switch (and the NOEMS) switch to the corresponding config.sys line since 
otherwise the performance for starting BAE graphic program modules will dramatically slow down. 

Note that you must reboot your computer if you made any changes to config.sys or autoexec.bat. Otherwise you 
might not be able to start BAE. 
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Linux Installation 

The baelinux directory on the BAE CD-ROM contains the baelinux.tgz and baelinus.tgz TGZ archive files with 
different BAE builds for Linux. Each of these TGZ files contains the directories bin (programs and setup files), baelib 
(symbol and part libraries), baeulc (User Language source files) and baejobs (examples and test jobs). The BAE 
software is supposed to run on all common Linux system with Kernel 2.0.x (S.u.S.E. 6.0 or later, RedHat, etc.). The TGZ 
files baelinhe.tgz and baelinhs.tgz contain the binaries for BAE HighEnd. An additional file named baeeng.tgz 
including the English BAE user interface setup is also provided. 

We strongly recommend that you have a look into the readme file from the baelinux directory of the BAE CD-ROM 
before installing the BAE Linux software. The readme file contains a list of the provided BAE Linux archive files and latest 
information and important instructions for installing the BAE Linux software. 

baelinus.tgz must be installed on Linux systems without Motif. baelinus.tgz contains a statically linked BAE 
version including all system and Motif libraries (libc6/glibc, lesstif/Motif1.2) required to run BAE on any Linux Kernel 2.0.x 
distribution. 

It is recommended to use the more efficient dynamically linked BAE version from baelinux.tgz (linked to libc6/glibc 
and Motif2.0) on Linux systems where Motif is already installed. The statically linked version from baelinus.tgz can 
always be used on Linux systems which fail to run the dynamically linked version. 

To install the BAE Linux software, simply mount the CD-ROM drive with the BAE-CD-ROM (e.g., under /cdrom), change 
to the directory where you want to install the BAE software, and unpack the appropriate archive file (e.g., 
baelinux.tgz) using the tar command as in 

> tar -xzfv /cdrom/baelinux.tgz  

The -z option is used to filter the TGZ file through the gzip utility. If your tar command does not support the -z option, 
simply use gzip and tar as in 

> gzip -dv /cdrom/baelinux.tgz  
> tar -xfv /cdrom/baelinux.tar  

To install the dynamically linked BAE HighEnd version, simply extract the baelinhe.tgz file after installing 
baelinux.tgz. To install the statically linked BAE HighEnd version, simply install baelinhs.tgz after installing 
baelinus.tgz. 

A configuration file is provided with productive BAE Linux versions. This configuration file (router.cfg) must be saved 
to the BAE program directory (bin, see above). To activate BAE Demo, the demo.cfg configuration file must be copied 
to router.cfg, to activate BAE Schematics, schema.cfg must be copied to router.cfg (see also Table 1). 

BAE is pre-configured with a German user interface. The English user interface can be activated by extracting the 
baeeng.tgz archive file from the CD-ROM baelinux directory to the destination directory. 
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UNIX Installation 

The BAE HighEnd archive files for UNIX workstation are provided in specific BAE-CD-ROM directories such as baehp 
for the HP version. These archive files contain the directories bin (programs and setup files), baelib (symbol and part 
libraries), baeulc (User Language source files) and baejobs (examples and test jobs). An additional file named 
baeeng.tgz including the English BAE user interface setup is also provided. 

The BAE HighEnd archive files for HP workstations are provided in the baehp directory on the BAE CD-ROM. Please 
see the readme file in the baehp directory for latest information and instructions on how to install the BAE HP software. 

To install the HP software, simply mount the CD-ROM drive with the BAE-CD-ROM (e.g., under /cdrom), change to the 
directory where you intend to install the BAE software, and unpack the baehp.tgz archive using the tar command as in 

> tar -xzfv /cdrom/baehp.tgz  

This installs the BAE HighEnd software with OSF/Motif interface. To activate the BAE HP software for X11, the 
baehpx11.tgz file from the baehp directory on the CD-ROM must be installed in the destination directory after installing 
baehp.tgz. 

A configuration file is provided with productive BAE UNIX versions. This configuration file (router.cfg) must be saved 
to the BAE program directory (bin, see above) To activate BAE Demo, the demo.cfg configuration file must be copied 
to router.cfg, to activate BAE Schematics, schema.cfg must be copied to router.cfg (see also Table 1). 

BAE is pre-configured with a German user interface. The English user interface can be activated by extracting the 
baeeng.tgz archive file from the CD-ROM baelinux directory to the destination directory after installing the UNIX 
software. 

Setting up the Linux/UNIX Environment 

The access rights must be set properly (i.e., execute for the programs, read access to the libraries, read/write access to 
the job files, all rights for the system administrator, special rights for the library manager, etc.). The user must have read 
access to the BAE program directory files ending on .cfg (for authorization check) and read/write access to the files with 
extensions .dat and .fnt. The user must also have write access in the working directory to enable temporary file 
creation. 

The Linux/UNIX shell environment variable PATH must point to the BAE programs directory to allow for BAE program call 
from any other directory. The PATH variable can be set automatically through shell profile execution (shell script 
.profile, .login, .bashrc or .cshrc, according to UNIX derivative, respectively). 
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1.5 Parameter Setup and Program Start 
BAE System Parameter 

The BAE software versions for Windows and Motif provide an interactive program for modifying the BAE system 
parameters. Under DOS, however, the BSETUP utility must be applied as described herein. 

The BAE software comes with a setup definitions file template named stdset.def which is installed to the BAE 
programs directory. This file contains the following commands for setting the BAE library access paths: 

SCMDEFLIBRARY("<libdir>\stdsym"); 
LAYDEFLIBRARY("<libdir>\laylib"); 

<libdir> is the path name of the BAE library directory. If the library e.g., has been installed to the directory c:\baelib 
under DOS or Windows then you should replace <libdir> with this path name to provide correct access to the BAE 
symbol libraries. If the library, e.g., has been installed to the directory /usr/bae/lib under Linux or Unix, then you 
should insert the following commands to the setup definitions file for providing correct access to the supplied BAE symbol 
libraries: 

SCMDEFLIBRARY(/usr/bae/lib/stdsym); 
LAYDEFLIBRARY(/usr/bae/lib/laylib); 

The setup definitions file can be transferred to the BAE setup file bsetup.dat using the following BSETUP program call 
(assuming stdset.def to be the name of the setup definitions file, and the BAE programs directory to be the working 
directory): 

> bsetup stdset  

The BSETUP utility program is also used for defining important system parameters such as the documentary layer 
definitions and the menu setup. The documentary layer definitions and assignments have major impact on how 
manufacturing data is generated. Thus it is strongly recommended to get familiar with the features of the BSETUP utility 
program before using BAE for the design of real layouts. See Bartels AutoEngineer User Manual - Chapter 7.2 for details 
on how to use BSETUP. 

User Language Programs, Menu Assignments, Key Bindings 

The BAE software installs many pre-compiled User Language programs to the ulcprog.vdb file of the BAE programs 
directory. The corresponding source files are are also provided in the User Language directory (baeulc). See Bartels 
User Language Programmer's Guide - Chapter 4 for a complete listing and short descriptions of the BAE User Language 
programs. 

Some of the installed User Language programs define implicit User Language program calls for activating a modified 
BAE user interface with many additional functions. You can add even more functions or you can modify and/or reset the 
predefined menu assignments and key bindings. For more details see section 11.5 of these Release Note. 

Usually, it is not necessary to (re-)compile the User Language programs delivered with the BAE software, since the 
compiled programs are installed to the ulcprog.vdb file of the BAE programs directory. Nevertheless, the User 
Language directory provides several batch files for automatically compiling all BAE User Language programs. The 
CPLSLL (ComPiLe with Static Link Library) batch file is recommended for compilation. The compile batch can be started 
in the User Language directory (baeulc) by entering 

> cplsll  

to an MS-DOS-Prompt (with the PATH variable pointing to the BAE programs directory) or with the 

> cplsll.bat  

command from a Linux or UNIX shell. The compilation process might last some time according to the power of your 
computer. 
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BAE Program Start and DDB File Access 

Use the following command to start the Bartels AutoEngineer from a DOS prompt or a Linux and/or UNIX command 
shell: 

> bae  

Design file access can be simplified by starting and/or running BAE from the design and/or project files directory. 

Under Windows, the Bartels AutoEngineer can also be started by selecting the bae.exe file using the Run function 
from the Windows Start menu. Windows also allows for application startup by double-clicking the application from 
Windows Explorer, and it is also possible to define an initial working directory for the application to start in. A shortcut to 
bae.exe can be placed on the desktop or the Windows Start menu to provide an even more convenient method of 
starting up the Bartels AutoEngineer. 

When installing the BAE software under Windows 95/98/ME/NT/2000/XP, a BAE program group with shortcuts for starting 
the BAE main menu (BAE Main Menu) and the BAE program modules (BAE Setup, Schematic Editor, Packager, Layout 
Editor, Autorouter, CAM Processor, CAM View) and for accessing the Bartels AutoEngineer User Manual (BAE User 
Manual) is added to the Windows start menu. 

The BAE DDB File option for creating a new BAE DDB file named New BAE DDB File is included with the New function 
from the Windows 95/98/ME/NT/2000/XP Desktop and Windows Explorer context menus to be activated through the right 
mouse button. The BAE DDB file context menus provide the BAE Schematic and BAE Layout options for loading the 
selected BAE file to the Schematic Editor and/or the Layout Editor. Double-clicking a BAE DDB file automatically loads 
the DDB file's standard layout element to the Layout Editor. The system suggests to create a new layout element if the 
DDB file does not yet contain a layout element with default name. 

Please consult your operating system documentation for more information on how to configure applications for startup. 

File Access Environment Variables 

Environment variable references in file name specifications are automatically substituted. This allows for definitions such 
as $BAELIB for the symbol library directory and combined specifications such as $BAELIB/laylib or 
$BAELIB/$STDLIB to be used for path and file name specifications in functions such as Select Library from the 
Settings/Parameter menu. The environment variables are not evaluated until they are actually referred for file access. The 
environment variables are stored with design files to be transferred to different computers where they can refer to 
machine-dependent path specifications defined through corresponding environment variables. Environment variable 
references are preceded with a dollar sign ($) and must be either entirely lower-case or entirely upper-case. The ~ 
character serves as an alias for the $HOME variable. Undefined environment variable references are substituted with 
empty strings. 
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System File Access Environment Variables 

The environment variables listed in table 3 are evaluated for advanced configuration of BAE system file access in network 
installations. 

Table 3: BAE System File Environment Variables 

Environment Variable 
System File 
Default Name Contents 

BAE_CFG  router.cfg BAE Configuration/License File 

BAE_BSETUP  bsetup.dat BAE System Parameters 

BAE_PARLIB  baeparam.vdb BAE Online Key Assignments 

BAE_ULCLIB  ulcprog.vdb BAE User Language Programs 

BAE_ULCHELP ulchelp.vdb BAE User Language Help Texts 

BAE_RULELIB brules.vdb BAE Rules Database 

BAE_LANG  language.vdb BAE Menu String Tables (language-specific) 

BAE_FONTLIB ged.fnt BAE Graphic Character Fonts 

BAE_SCMLIB  scm.dat SCM Color Tables 

BAE_GEDLIB  ged.dat PCB Layout Color Tables 

BAE_RUTLIB  rutparam.dat Autorouter Parameter 

BAE_CEDLIB  ced.dat IC Layout Color Tables 

BAE_CAMLIB  cam.dat CAM Gerber Aperture Tables 

BAE_DCOLLIB bae.col BAE Display Color Table 

BAE_PCOLLIB baep.col BAE Printer Color Table 

BAE_WINLIB  baewin.dat 
baexwin.dat 

BAE Windows Position File 

BAE_CLIPB  baeclipb.dat BAE Clipboard File 

Environment variables must specify complete paths to the corresponding system files. This feature can be used in 
definitions such as 

set BAE_WINLIB=d:\bae\user1.dat 

where access to a machine-specific Windows positions file in network installations with central BAE programs directory is 
established. 

System files without environment variable definition are accessed from the BAE programs directory using the default 
system file name. The BAE_PROGDIR environment variable allows for the specification of an alternative system file 
directory. 

Windows System Font Selection 

The ANSI_FIXED_FONT system font is used on default for displaying status line and dialog text in BAE Windows 
versions. Alternatively, SYSTEM_FIXED_FONT can be selected by assigning an arbitrary value to the BAE_OLDFONT 
environment variable if ANSI_FIXED_FONT isn't suited for the configured screen/monitor resolution. 
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1.6 User Interface and General Functions 
BAE-System Files 

The naming conventions for version-dependent BAE system files have been changed. These files are now always 
installed with file name extension .vdb to the BAE programs directory. This includes ulcprog.vdb (compiled User 
Language programs of the BAE software; previously in bsetup.dat), ulchelp.vdb (help texts for the User Language 
programs of the BAE software; new), brules.vdb (compiled rule definitions of the BAE software; previously 
brules.dat) and language.vdb (menu texts for non-German user interfaces of the BAE software; previously 
language.dat; optionally installed). This simplifies the transfer of existing user-specific system data (such as color 
tables, Gerber aperture tables, etc.) after BAE update installations to new directories. This can now be accomplished by 
simply copying the files ending on .dat, .fnt and .ini from the old BAE programs directory to the programs directory 
of the new BAE installation. 

Numerical Value Input 

A comma can be used instead of a decimal point when entering numeric values for coordinates, dimensions, angles and 
scaling factors through dialogs. 

Zoom Functions 

A mouse pointer memory for restoring the mouse position has been added to the Zoom In and Zoom Out available 
through the + and - keys. This allows for repeated zoom in/out operations at a specific position without the need to 
correct the mouse position. 

Windows Directory Selection Dialog 

The Windows standard dialog for folder selections is now activated for directory selections under Windows. 

Screen Redraw under Windows 

The Show window contents while dragging screen setting under Windows caused flickering when moving an application 
window over the BAE window. A 200ms BAE screen redraw delay has been implemented to avoid this problem. 

Multi-column Selection Listboxes 

A series of element and name selection dialog boxes have been replaced by multi-column selection listboxes with 
improved selection element overview. 

User Language-Programmauswahl 

A User Language program selection dialog has been implemented for the Run User Script function. The name of the 
previously called User Language program is pre-selected in this dialog. 

Mouse Wheel Support under Windows 

Mouse wheel support has been added to the BAE Windows versions. Mouse wheel turns cause the BAE screen contents 
to scroll vertically by a quarter of the BAE display screen height. Pressing the middle mouse button or the mouse wheel 
prior to the mouse wheel turn sets the scrolling distance to a multiple of five of the subsequent mouse movement. Mouse 
wheel turns are translated to following key codes if the left or right mouse button is pressed: '{' (left mouse button, 
forward movement), '}' (left mouse button, backward movement), '[' (right mouse button, forward movement) and ']' 
(right mouse button, backward movement). With the BAE standard/default key setting, the zoom out/in and rotate left/right 
functions are assigned to these keys. 

Warning 

The extended BAE mouse wheel functions are only operational if the installed mouse driver isn't configured for non-
standard mouse wheel event handling (such as for scroll movement translations for applications without mouse wheel 
support). 

BAE System Character Font 

The special characters ², ³, µ, € (Euro symbol), § and ° have been added to the stdwin.fon vector character font 
definition file supplied with the BAE software. The modified standard character font has been added to the ged.fnt 
system font file. 
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1.7 Symbol and Part Libraries 
The layout libraries have been completely revised. The layout elements from the front.ddb (front panel design 
elements), smd.ddb (SMD part definitions) and steckver.ddb (connector part definitions) layout library files have been 
transferred to the centrla layout library laylib.ddb. A series of pad and padstack definitions have been "standardized" 
using the GENLMAC User Language program. 

PDF files displaying all graphic symbols of the officially released BAE libraries are provided in the pdflib directory of the 
BAE-CD-ROM. 

A series of useful library management User Language programs for library management (library check, automatic symbol 
edit, automatic generation of library documentation, etc.) are installed with the BAE software. See Bartels User Language 
Programmer's Guide - Chapter 4 for a complete listing of the User Language programs provided with the BAE software. 
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2 Schematic Editor 
2.1 General 
Context Functions 

The Element Types function has been added to the toolbar menu for configuring the left mouse button context function. 
This function is used to restrict context processing to certain element types such as symbols or texts. 

Jump Absolute 

The Jump Absolute dialogs of the element placement context functions are initialized with the old element coordinates 
and/or the last corner point coordinates. 

2.2 Symbols, Labels 
Renaming/Renumbering Symbols 

The functions for renaming and/or renumbering symbols from the Other Functions submenu of the Symbols menu have 
been changed to retain symbol name and attribute text positions previously assigned with the Move Name bzw. Move 
Attribute functions. 

Part Search 

Part values are now displayed in the dialog of the Search in list function from the Find Part submenu of the View menu. 
Plan, Name and Value buttons have been added for sorting the part search selection list. 

Symbol Placement 

The context menu of the Move Symbol/Label provides the new Jump relative function for moving the selected symbol 
relative to its old position. 

Symbol Name Pattern 

The Part Name Pattern function for setting part name patterns for automatic symbol/part naming has been changed to 
support name patterns with * characters for number fields without fixed field length. On default, this field starts counting 
from 1. 

The Standard and Number Scan options for selecting different part name pattern mode on SCM sheet level have been 
added to the Part Name Pattern function. Standard is the default mode for creating part names beyond the largest used 
part number. Number Scan is designed to fill existing part numbering gaps, and it can be used to initiate a name search at 
a specific start number. Number Scan is specific to the current SCM sheet. allowing for the specification of different 
symbol name patterns for different SCM sheets of a project. 

Label Placement with Net Name Selection 

The Macro List button for activating a project/standard library label selection dialog has been added to the net name input 
window of the Add Label function. 

The List button from the Add Label function activates a net name selection dialog with all net names from the current SCM 
sheet. This dialog also provides a Project Scan button for scanning the net names from other SCM sheets of the project. 
The net name selection dialog created by Project Scan appends different indicators according to net name scopes. 
(lokal) is used for net names which are only used on the current SCM sheet. (global) is used for net names which 
are used on the current SCM sheet and on other SCM sheets of the project. (extern) is used for net names which are 
only used on other SCM sheets of the project. The system uses a cache for memorizing the net names from other sheets 
to increase the performance of repeated Add Label calls. 

Marker and Label Selection 

Browse buttons for project/standard library element selection dialogs have been added to the Select Pin Symbol, Select 
Junction Point and Select Label Macro options of the Settings dialog. 
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Attribute Sorting 

ATTR_ORD_*_STD entries in the bae.ini file can be used to set the sort mode for the attribute selection menus of the 
Assign Value(s) and Attr. Default Val. functions. Previously, the attribute selection menu enties were sorted according to 
the attribute placement sequence. 

2.3 Connections 
Bus Taps 

The Tap Bus function has been changed to allow for optional, comma-separated step value inputs to bus tap name range 
specifications. I.e., d(1-5,2) input to the Tap Bus function provides the bustaps named d1, d3 and d5 for placement. 
Bus taps can also be automatically placed by appending a plus sign + to the bus tap name range as in d(0-7+) where 
d2 through d7 are automatically placed in a row with its direction and bus tap distances derived from the placement of d0 
and d1. 

2.4 Graphics 
Rotate/Mirror Graphics 

New functions for rotating and/or mirroring the selected graphic element have been added to the context menus of the 
Move Graphic and Copy Graphic functions. 

2.5 Text, Attributes 
Multi-line Texts 

The Multi Line Text submenu with functions for creating and manipulating multi-line texts with more than 40 characters 
has been added to the Other Functions of the Texts menu. Multi-line texts are internally stored as multiple texts with rule 
system ids for defining their connectivity. The left bottom corner of the surrounding text rectangle is the reference point for 
text placement functions. Multi-line texts should only be edited with the Multi Line Text functions to preserve the 
connectivity and the relative positioning of these texts. 
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3 Packager 
3.1 Report File 
Connected and/or joined net indicators have been added to the project-specific .fre report file created by the Packager. 
The name of each sub-net of a joined net is listed on a separate line with a Joined with indicator. These indicators can 
be used to search and/or check for unintentionally connected nets. 
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4 Layout Editor 
4.1 General 
Context Functions 

The Element Types function has been added to the toolbar menu for configuring the left mouse button context function. 
This function is used to restrict context processing to certain element types such as parts or texts. 

Jump Absolute 

The Jump Absolute dialogs of the element placement context functions are initialized with the old element coordinates 
and/or the last corner point coordinates. 

Layer Default Mode 

The Layer Default Mode parameter for setting a default layer for the placement of traces, polygons and texts has been 
added to the Settings dialog from the View menu. The No Default standard mode deactivates the default layer for non-
trace elements, causing layer specifications prompts as required. The Use Edit Layer mode places new elements onto the 
currently selected preference layer. The Last Used Layer Default Mode places new elements onto the previously used 
preference layer. A layer prompt is automatically activated if the default layer mode/selection is not allowed for the new 
element. The context menus of the functions for placing new elements provide a Change Layer option. 

4.2 Display, Design Rule Check 
Color Table Selection 

The color table name prompt of the Load Colors functions has been changed to display the name of the previously loaded 
color table as default. This feature can be used to reload standard color setups after manually changing color table 
entries. 

Element Query 

The 18 character width restriction of Query Element info popup window has been removed. The info window is now 
automatically resized to allow for the display of long macro and net names. 

DRC Error List 

Power layer errors indicated by the Report function are now also included with the DRC Error List output. Any deactivated 
and/or invisible (black) color settings for layers with DRC errors are automatically activated and/or set to white upon error 
display requests. 

4.3 Parts, Placement 
Pin Row Placement 

A dialog with controls for specifying the pin placement parameters (pin name prefix, pin name suffix, pin numbering with 
or without leading zeros, etc.) has been implemented for the Place Pin Row function from the Part Edit Func. submenu of 
the Parts menu. 

Pad Placement Layer Display 

The current pad layer is now indicated and/or pre-selected in the layer selection menus and dialogs of the pad placement 
functions on padstack level. This safeguards against wrong pad selections when editing multipad and/or multilayer 
padstack definitions such as blind and buried vias. 
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4.4 Traces, Routing 
Airline Display during Manual Routing 

A dynamic airline to the closest pin of the currently routed net is displayed whilst adding a new trace or moving a trace 
corner. The display mode for this airline is selected through the Airlines Display option from the Settings dialog of the 
Settings menu. 

Trace Placement Layer Display 

The current trace signal layer is now indicated and/or pre-selected in the layer selection menus and dialogs of the 
interactive routing function submenus. 

4.5 Graphic, Copper Areas 
Polygon Layer Change 

The Change Layer option has been added to the context menus of the Move Area and Copy Area functions and the 
functions for placing the first point of new areas and/or lines. Only valid layers for the currently processed polygon type 
are provided for selection. 

4.6 Text, Drill 
Text Layer Change 

The Change Layer option has been added to the context menus of the Add Text, Move Text and Copy Text functions. 

Text Positioning 

The context menu of the Move Text function provides the new Jump relative function for moving the selected text relative 
to its old position. 

Multi-line Texts 

The Multi Line Text submenu with functions for creating and manipulating multi-line texts with more than 40 characters 
has been added to the Other Functions of the Texts menu. Multi-line texts are internally stored as multiple texts with rule 
system ids for defining their connectivity. The left bottom corner of the surrounding text rectangle is the reference point for 
text placement functions. Multi-line texts should only be edited with the Multi Line Text functions to preserve the 
connectivity and the relative positioning of these texts. 
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5 Autorouter 
5.1 Parameter Setup 
Control and Strategy Parameter Settings 

The Save Parameters and Load Parameters functions for saving and loading Autorouter Control and Strategy parameter 
settings have been added to the File menu. Parameter data sets are saved to the rutparam.dat file in the BAE 
programs directory. The standard entry set contains the parameters at Autorouter startup and can not be modified. 

5.2 Autorouter Algorithms 
BGA Fanout Routing and Micro Via Support 

New Autorouter algorithms for internal pattern recognition and pin pattern routing have been implemented. These 
algorithms are designed to ignore standard design rules in special cases to allow for the placement of vias at or in pins. 
Pin patterns are used for BGA (ballgrid array) fanout routing and micro via placement on pins ("via-in-pin"). Both options 
can be activated through the Control dialog. BGA fanout routing and micro via placement are only applied for SMD pins 
without drill hole and single signal layer assignment. BGA pins are recognized through exact matrix placement patterns. 
The BGA Fan Out option takes priority over the Micro Via option to ensure that a BGA pin is not connected through a 
fanout via and a micro via at the same time. Micro vias are automatically centered on the connected pin. Micro vias are 
generated with a pin layer pad and a single inside layer pad. BGA fanout vias are placed at the BGA pin side opposite to 
the center of the ballgrid array. The BGA Fan Out All option activates BGA fanout routing for all BGA pins. The BGA Fan 
Out Inner option restricts BGA fanout routing to BGA pins which are not placed at the outside of BGA parts.  

Previous BGA routing solutions often featured pre-routed, fixed vias or even pre-placed vias on BGA part symbol 
definitions. Not only eliminate the BGA Fan Out and Micro Via options the need for such layout preparations, they also 
avoid redundant vias at non-netlist pins or otherwise connected pins, thus increasing the routing area on inside layers 
significantly. 

Blind and Buried Via Routing 

The Via Processing parameter with the Standard, Buried advanced and All advanced options has been added to the 
Strategy menu. The Standard default option activates the standard via position check. The Buried advanced option 
activates an enhanced via position check for blind and buried vias. The All advanced option activates an enhanced via 
position check for all via types. The enhanced via position check increases the routability signifincantly, especially when 
combinations of small and large via diameters are used for partial and all-layer vias. 

Warning 

The enhanced via position check can cause a significant increase in memory requirements when applied on printed circuit 
boards with large free areas. 

Via Offset 

The new Other Grid w. ofs option for the Routing Grid setting from the Options menu can be used to define via offsets for 
arbitrary routing grids. 

Vias to Split Power Planes 

The Autorouter is now capable to create via connections to split power planes which are not associated with power 
layers. 

Sub-grid Rip-Up Routing Resolution 

The halfgrid Rip-Up routing resolution has been dramatically increased. 

Rip-Up and Optimizer Cleanup Routing 

New data structures have been introduced to increase the efficiency of Rip-Up and Optimizer Cleanup routing. Rip-Up 
and Optimizer Cleanup routing procedure CPU time requirements for large PCB boards with a high number of pins and 
vias have been reduced by several factors. 
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Dealing with Internal Router Errors 

Internal router errors should be reported to Bartels System. In the rare case of an internal error, the Autorouter tries to 
save the current routing result in main memory and to a .bak file. A ruterr.log error log file is also generated if the 
error occurred at a specific routing matrix position. This error log file is intended to assist Bartels System in locating and 
fixing the bug. 

5.3 Autorouter Batches 
Batch Setup 

The maximum number of Autorouter batch procedures to be defined with Batch Setup has been increased to 20. 

Router Batch Parameter Settings 

The Load Settings function has been added to the Batch Setup function. Load Settings loads Autorouter control and 
strategy parameter sets previously saved with Save Parameters function from the File menu. Thus it is possible to set 
special predefined routing parameters for different routing procedures of the router batch. 

Saving and Loading Router Batches 

The Save and Load buttons for saving and loading router batches have been added to the Batch Setup dialog can. Router 
batches are stored to the rutparam.dat file in the BAE programs directory. The rutparam.dat file provided with the 
BAE software contains the diagonal example router batch for diagonal routing. diagonal consists of a Full Autorouter 
run with standard settings and subsequent Optimizer runs for diagonal routing with deactivated Optimizer Cleanup. 



Bartels AutoEngineer  Version 6.0 

Release Notes  Page 25 

6 CAM Processor 
6.1 Gerber Output 
Aperture Table Definition 

The Edit Apert. Table function activates a dialoge with aperture parameter input fields. This allows for aperture parameter 
modifications without having to enter complete aperture definitions. The dialog provides buttons for sorting the aperture 
table by D-Code, type or size. The List Apertures button lists all aperture table entries in a window with copy/paste 
functionality. 

6.2 Drilling Data Output 
Tool Tolerance 

Positive and negative rule system drill tool tolerance value assignments are now considered by all drilling data output 
functions. I.e., drill tools are generated for each drill tool diameter and tolerance value combination, thus allowing for the 
distinction of drill holes with identical diameters and different drill tool tolerances. 
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7 CAM View 
7.1 Parameter Setup 
Gerber Aperture Table Definition 

The Edit Apert. Table function activates a dialoge with aperture parameter input fields. This allows for aperture parameter 
modifications without having to enter complete aperture definitions. The dialog provides buttons for sorting the aperture 
table by D-Code, type or size. The List Apertures button lists all aperture table entries in a window with copy/paste 
functionality. 

7.2 Gerber Data 
G36/G37 Areas 

The Create Layout function from the File menu is now capable of generating layout areas from Gerber G36/G37 codes. 

The Report function displayed arbitrary values for G36/G37 codes with zero line lengths. This problem has been solved. 

Layout Generation 

The Create Layout function from the File menu is now using aperture size definitions from the Gerber input file when 
creating documentary lines. 
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8 Bartels User Language 
8.1 General 
This section describes general changes to the User Language specification. See Bartels User Language Programmer's 
Guide - Chapter 2 for a detailed description of the User Language specification. 

Internal User Language Version 

The internal version of BAE Version 6.0 User Language has been changed. All User Language programs compiled 
under earlier BAE versions won't execute in the BAE Version 6.0 User Language Interpreter environment (error 
message User Language program version incompatible!). This means that each User Language program 
compiled under earlier BAE Versions must be recompiled under BAE Version 6.0 to regain compatibility. 

8.2 User Language Compiler 
This section describes the news and changes introduced to the User Language Compiler. See Bartels User Language 
Programmer's Guide - Chapter 3 for detailed information on how to operate the User Language Compiler. 

Preprocessor Statements 

A series of possible caller type specifications have been added to the #pragma preprocessor statement for setting the 
caller type of the compiled User Language program. The following table lists the valid #pragma caller type specifications: 

Caller Type Valid Interpreter Environment(s) 

ULCALLERSTD all BAE program modules 

ULCALLERCAP all Schematic Capture program modules 

ULCALLERSCM Schematic Editor 

ULCALLERLAY all Layout program modules 

ULCALLERGED Layout Editor 

ULCALLERAR  Autorouter 

ULCALLERCAM CAM Processor 

ULCALLERCV  CAM View 

ULCALLERICD all IC Design program modules 

ULCALLERCED Chip Editor 
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8.3 System Functions 
This section lists the new and changed User Language system functions. See Bartels User Language Programmer's 
Guide - Appendix C for a detailed description of all system functions. 

New System Functions 

The following new User Language system functions have been implemented for BAE Version 6.0: 

IP System Function Short Description 

bae_getpolyrange Get internal BAE polygon range 

strextractfilepath Extract directory name from a file path name string 

strgetvarfilename Get environment variable expanded file name string 

STD 

strgetpurefilename Extract file name from file path name string 

scm_askrefname SCM reference name selection SCM 

scm_asktreename SCM net name selection 

LAY lay_getpowpolystat Layout power layer polygon status query 

ged_getlaydefmode Get GED default layer mode 

ged_getlayerdefault Get GED default layer 

ged_powlayerrcnt Get GED power layer error count 

ged_setlaydefmode Set GED default layer mode 

GED 

ged_setlayerdefault Set GED default layer mode 

Changed System Functions 

A new layer query type for power layer selection has been added to the ged_asklayer function. 

A new parameter for returning the net name and a mode for displaying the No Net Assignment button in the net selection 
menu have been added to the ged_asktreeidx function. 

8.4 BAE User Language Programs 
BAE installs some 200 pre-compiled User Language programs to the ulcprog.vdb file of the BAE programs directory. 
Additionally, the User Language source files (more than 3.5 Mbytes; more than 120,000 lines) are installed to a special 
directory (baeulc). See Bartels User Language Programmer's Guide - Chapter 4 for a complete listing and short 
descriptions of the BAE User Language programs. 

Include Files 

The User Language include files already delivered with the previous BAE Version have been revised and extended by a 
series of new definitions and functions. 

New User Language Programs 

The following new User Language programs are provided with BAE Version 6.0: 

IP Program Name Short Description 

SCM SSYMPATT SCM Symbol Name Pattern Setting 

Changed User Language Programs 

The User Language programs already delivered with the previous BAE Version have been revised and extended by 
many new features and functions. A series of significant improvements and enhancements have already been mentioned 
in the previous sections of these Release Notes. 
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